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Installation

The Portus installation process uses the Eclipse based "Find and Install" dialog to download and
deploy the required installation files. If you are new to Eclipse, see the Introduction to Eclipse
section.

■ Latest Release Notes
■ Installation Prerequisites
■ Control Centre installation - all platforms
■ Server Installation Procedure - Windows
■ Server Installation Procedure - z/OS
■ Server Installation Procedure - z/VSE
■ Server Installation Procedure - All other platforms
■ Copying or upgrading server configurations
■ Uninstall
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Overview

The Portus software consists of two components:

■ The Portus Server component runs locally to your "resource". In this instance a resource is
defined as an Adabas, MySQL, PostgreSQL or SQL Server database. It can also be defined as a
Natural program, an LE program, a shared library or a DLL.

■ The Portus Control Centre component is a central GUI used to configure and monitor one or
more Portus Servers. This component runs within the Eclipse IDE, and must be run on Linux
or Windows.

Portus Control Centre prerequisites

■ On Linux, the GTK2 Windowing system and its dependencies.
■ A Java Runtime Environment (minimum: JRE 1.6)

Portus Server Operating System Prerequisites

Portus is currently supported on the following platforms:

■ Windows 2003/2008 Server (standard edition and enterprise edition)
■ Windows XP Professional
■ Windows 2000 Professional, Server and Advanced Server
■ Windows Vista
■ Windows 7

Important: All Windows 64-bit platforms are supported by running the SOA Gateway in
32-bit compatibility mode.

■ Linux x86 (32-bit)
■ Linux x86 (64-bit)
■ Linux s390x (64-bit)
■ AIX 5.3 / 6.1 (64-bit)
■ Solaris 9/10 SPARC (64-bit)
■ HP-UX 11i v2 Itanium (64-bit)
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■ z/OS
■ z/VSE

z/OS

A userid and password that can be used on the z/OS system.

Appropriate RACF/ACF2/TOP-SECRET access to create datasets.

Portus installation requires that server files be sent to the z/OS host, therefore an accessible ftp
server must be running on this host.

A free TCP/IP port that can be used (One per Portus)

The ability to add a started task or submit a long running job.

Adabas databases accessed via Portus must be UES-enabled.

The Adabas WAL813.L003 as well as WAL813.LOAD (or above) libraries must be in the STEPLIB
chain, otherwise no access to Adabas will be possible from the Portus server.

Under certain circumstances, the Adabas link routines may not pick up the SVC and DBID values
specified via DDCARD. In this case the SVC number and Database Id must be zapped into
ADALNKR, as described in the Adabas installation documentation, and themodifiedADALNKR
made available in a STEPLIB library ahead of the one containing the original, unzapped version.

Windows

Microsoft Visual C++ 2005 Libraries. The redistributable can be downloaded here

Microsoft Visual C++ 2008 Libraries. The redistributable can be downloaded here

It is strongly recommended that you restart Windows after this installing this redistributable.

Linux

The Portus installation scripts require the bash shell.

The Portus installation requires that server files be sent to the targetmachine, therefore an accessible
ftp or SSH server must be running on the target machine.

3Server and Control Centre Installation

Installation Prerequisites

http://www.microsoft.com/downloads/en/details.aspx?familyid=200B2FD9-AE1A-4A14-984D-389C36F85647
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=9b2da534-3e03-4391-8a4d-074b9f2bc1bf


Additional Software Prerequisites

Portus requires the following software versions

■ Minimum Adabas v5 on OpenSystems platforms (Windows / Linux / Unix); Adabas 6.1.3 +
Adabas Client (ACL) 6.2.1.8 required for LOBs (large objects) access

■ Any supported UES-enabled Adabas version on the mainframe (v7.4 and higher); Adabas 8.1
or higher required for LOB access

■ iTrac ADAOS-3371 must be applied
■ To use any relational database driver (MySQL/Oracle/Postgres/etc) ODBC must be installed,
and the appropriate driver interface for your database (e.g.MyODBC/OracleODBC/psqlodbc/etc)
must also be installed.
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Prerequisites

Java is required to run the Eclipse SDK

If you already have Java Runtime Environment (JRE, v1.6 or higher) installed, youmay skip this step.

To find out what level of java you have installed, run the command java -version from either a
shell ( Unix/Linux) or command box (Windows) depending on your system.

If Java is not installed already in your environment, follow these steps

■ Install the latest version from here.
■ The minimum version, JRE 1.6 is available here
■ Find the "Java Runtime Environment (JRE)" and download it.
■ Accept the license agreement, and choose the correct package for your platform.
■ Start the Java installer (for example double-click) and follow the instructions.

The Java download site provides detailed install instructions.
■ Once the installer has finished, Java is installed in your environment.

Download and install Eclipse

The Eclipse OpenSource framework forms the base for the Portus administration and monitoring
tool, the 'Control Centre'.

Eclipse 3.6 (or higher) is required to run the Portus Control Centre. If you have a valid copy of
Eclipse installed already, you may skip this step.

Steps required to install the Eclipse framework:

1. Download Eclipse version 3.6 for your environment :

forWindows x86

forWindows x86-64

for Linux x86 GTK2

for Linux x86-64 GTK2

2. Unzip the downloadedpackages, thiswill create a directory structure under a top-level directory
named 'eclipse', at the selected file system location. for example C:\eclipse on Windows when
unzipping into C:\, or /user/eclipse on Unix/Linux if the selected location was /user
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3. Start Eclipse - 'eclipse.exe' on Windows, './eclipse' on Unix/Linux, from the top-level eclipse
directory.

If you are new to Eclipse, please take the 'Getting started with Eclipse' tour before continuing.

Install the Portus Control Centre from an Update Site

■ Start the Update Manager, which can be found on the Eclipse main menu underHelp -> Install
new software.

Note: As the Eclipse Update Manager may need to get to an external site, you may have
to specify a HTTP proxy in order to access it from an intranet. Instructions on how to set
the HTTP proxy can be found in the Troubleshooting section.

■ In theWork with text box, enter the URL

http://cloud.ostiasolutions.com/Portus/panamaUpdateSite
■ TheUpdateManagerwill now contact the update site and display the list of available downloads.

■ An empty box next to the features name indicates that the feature is not selected
■ Choose a feature by clicking the checkbox beside it. A tick appears in the box beside the features
■ You should always select the 'Portus Control Centre' catagory
■ You should also select the install kit(s) which correspond to the system that will run the Portus
Server

■ In some cases, you may also drill down by expanding the feature menu.
■ Once finished, clickNext and the required features will be downloaded.

■ Depending on the amount of features selected, and the speed of your connection, this may take
some time.

■ Once the download has finished, you will be presented withe Legal Notices dialog. Read and
Accept the license agreement before continuing.

Check I accept the terms in the license agreement and clickNext

■ Review the features to be installed, and click Finish

■ The selected features will now be installed.
■ If the features have not been signed, you will be asked if you wish to continue with the installa-
tion.
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If the features have been signed, youwill be asked if youwant to install a digitally signed feature.

Either way, clickOK

■ Restart Eclipse when prompted.

Next Steps

Now the Portus Control Centre has been installed. Proceed to the relevant server installation section
choosing a link below.

Server Installation Procedure - Windows

Server Installation Procedure - z/OS

Server Installation Procedure - All other platforms
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Important: The information here is forminor updates, e.g. hotfixes, patches, etc. For all major
updates (e.g new software release), Portus should be installed anew, and existing services
should be copied using the Control Centre. See here for more details.

The followingwill guide you through the process of updating your existing Portus Control Centre
and Server.

The Portus updates are provided via an Eclipse wizard. When you update your Control Centre
(the "Base" feature), the updates are applied after the Find and Install process has finished, and
the Eclipse IDE restarts.

Your Portus server will not be updated until you re-deploy the server.

Using the Eclipse Wizard to find and install updates

It is assumed that the Portus Control Centre has already been installed, as detailed in the respective
section of this installation guide.

This section describes how to update the Control Centre and also the server installation kit(s) to
a level higher than the one currently installed

Eclipse checks a list of available software sites for updates. These sites can be configured by selecting
Window -> Preferences -> Install Update -> Available Software Sites.

The Portus entry in this list needs to be checked for updates to function correctly.

Ask Eclipse to check for updates by selecting Help -> Check for Updates. All currently installed
features will be checked.

If you wish to install additional server kits for deployment, use Help -> Install New Software.

If newer versions are found, they will be downloaded and you will be asked to restart eclipse.

Update Server - Windows

If you followed the steps above, you now have successfully updated your Control Centre, and
have downloaded the updated server installation files.

Important: The Portus Server has not been changed at this stage. You need to re-deploy to
update the server.

Server and Control Centre Installation10
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You must uninstall your existing Portus Server before continuing. The uninstall process will not
uninstall your existing dataviews and schemas. You may want to make a backup of your existing
configuration, and restore it once the new installation is complete.

■ Make a backup of%ALLUSERSPROFILE%\Portus 4.2.1\configuration\sampleConfig-win.xml
,%ALLUSERSPROFILE%\Portus 4.2.1\configuration\RisarisLicense.xml andC:\ProgramFiles
(x86)\Ostia\Portus 4.2.1\Apache22\conf\httpd.conf

Follow the instructions here to uninstall Portus

Now restart the Portus deployment wizard, and follow the normal server installation process. See
here for more details

Restore your configuration by putting back the previously saved sampleConfig-win.xml and ht-
tpd.conf

Stop and start Portus, and this completes the update.

Update Server - non-Windows Platforms

If you followed the steps above, you now have successfully updated your Control Centre, and
have downloaded the updated server installation files.

Important: The Portus Server has not been changed at this stage. You need to re-deploy to
update the server.

z/OS Update

You can run a new Portus server side-by-side with the existing server, so long as the datasets
names and the port that the server listens on are different.

Alternatively, you can re-deploy a new server, and simply use the new LOAD library in the
STEPLIB of your existing installation.

Follow the instructions here to deploy the updated server.

Important: Ensure you choose new dataset names.

Follow the instructions here to copy web services between servers.

*nix Platforms

You can run a new Portus server side-by-side with the existing server, so long as the installation
location and server port are different.

11Server and Control Centre Installation
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Alternatively, you can transfer the updated installation files, and provide the -update option when
starting the installServer.sh script.

Follow the instructions here.

Important: If you want to create a new installation, ensure you choose a new installation
directory, and a server port different from the existing.

Follow the instructions here to copy web services between servers.

If you have updated an existing installation, then the update is now complete.
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The following will guide you through the process of installing and starting the Portus server.

Using the Deployment Wizard for Linux/Unix type systems

The next step then is to install and start the Portus server. To do this, you may have to deploy files
to a remote machine. For example, you want to run your Portus Control Centre on Windows, but
your Portus server on Linux. You can use the deployment wizard to send the deploy the required
files to Linux and start your server.

■ If this is the first time you've started the Control Centre, the Portus Perspective will be activated
automatically.

If, for some reason, the Portus Control Centre perspective has not started, clickWindow ->Open
Perspective -> Other and choose Portus Control Center (Admin) from the list. ClickOK

You will be asked to specify a project name or accept the default. Usually you will now simply
click the 'Continue' button, whichwill then start the 'DeploymentWizard' to guide you through
the process of defining your server within the Portus Control Center and transfer (FTP) the in-
stallation files to the Portus Server target machine.

■ If you, for whatever reason, opt to NOT run the Deployment Wizard at that time, you can start
the wizard anytime later on by clicking the Deployment action button in the title bar of the
'Portus Servers' view

■ The Deployment Wizard will now start

Server and Control Centre Installation14
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■ From the drop-down menu, choose the installation files you want to deploy. These files were
downloaded as part of the Find and Install step above.

■ Select your Portus license file.
■ ClickNext
■ The following screen allows you to either select an existing Portus server to deploy to (a list of
servers knownwithin your Control Centre environment is presented), or to define a new Portus
server to the Control Centre. This server definitionwill be used for both the deployment process
as well for (remote) server administration later on.

■ To define a new server:

1. Enter a 'friendly name'. This name will be used to refer to a Portus Server without needing
to enter the hostname (or IP) later on.

2. Enter the hostname or IP of the machine on which the Portus server will run. This host/IP
will be used to send the install files ( via FTP ) andwill become the host/IP that you use when
issusing requests to Portus.

3. Enter the port which you would like Portus to listen for connections on.

A new Apache web server will be installed, you must ensure that the port choosen here is
available for use on the server machine.

The port entered here will utimately be the port that Portus uses to service requests.

4. Important: Once you have filled in all of the above, click 'Add Server'

5. The server will now be added to your Portus Control Centre 'Servers View' for later use.
■ Alternatively, if an already defined server is to be used (i.e. installation files deployed to it),
check 'Deploy to existing Portus Server' and select a server from the list in the 'Existing Server
Information' section.

■ Select the transport mechanism, one of
■ FTP: only transfer, actual installation has to be carried out by logging on to the target system
and starting the installation script manually

■ SSH: this method optionally allows for automatic ("silent") installation, no separate login to
the remote system required. After the files have been transferred the install script will be ex-
ecuted by the deployment wizard, the Portus server (optionally) be started.

■ ClickNext
■ The next screen is used to deploy the installation files to the target machine, i.e. the machine is
where the Portus server will run. Which of the following paths will be taken depends on the
choice made regarding the transport mechanism above.

FTP:
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■

■ The Host / IP will have already been filled by what has been specified on the previous page.
■ Enter the username which is used to login (via FTP) to the server machine (if required)
■ Enter the password (if required)
■ Enter a directory to send the installation files to. This directory may be relative to the login
directory, or can be a fully qualified path name. The directory will be created if it does not
exist.

■ If your FTP server requires a port other than 21, you can specify that by selecting Specfic FTP
Port and entering the FTP port number.

Server and Control Centre Installation16
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■ If your FTP server requires passive mode transfers, you can enable this by selecting the
Passive Mode checkbox

■ Important: Click the Start FTP button to begin the FTP.

■ The Additional parameters group will allow you to enter (if required) additional information
required for the operation of the driver(s) to be installed. Parameters related to all licensed
drivers are queried here, you may omit those for all drivers you do not intend to use.

■ Once the FTP has completed, you need to logon to the target machine, and run the server-
specific installation steps.
■ Server installation steps

SSH:

■ To just transfer the install files and not have the Deployment Wizard run the installation re-
motely, fill in your login credentials, sepcify a directory to transfer the files to and click Start
Install.

17Server and Control Centre Installation
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Once you have started the transfer you will prompted for your confirmation that it is really
the host you want to send the files to.

■ If you want the Deployment Wizard to also schedule the actual installation remotely, check
the "Silent (automatic) installation" option, set the various directories, then click Start Install.

■ Important: If you do not want to do the installation silently, follow the instructions here

■ Important: If you are updating an existing installation, the "Silent (automatic) installa-
tion" should not be checked.
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WhendifferentUser IDs are specified for the "login" and "handle server requests", the following
will prompt you for confirmation, please check if the authorization level for the user running
the Portus server is sufficient to access and execute files created by the "login user".
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If the directory specified to contain the install log file does not exist youwill be asked to create
it before the installation can continue.

All other files will be created by the installation scripts.

The overall transfer status will be shown directly within the Deployment Wizard window,
for larger files an external window will pop up to indicate the progress.

■ Note: To enable "passwordless logins" execute the following steps:

1. Run the command : ssh-keygen -t dsa

e.g.

Generating
public/private dsa key pair. Enter file in which to save the key
(/home/myUser/.ssh/id_dsa): Enter passphrase (empty for no passphrase): Enter
same passphrase again: Your identification has been saved in
/home/myUser/.ssh/id_dsa. Your public key has been saved in
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/home/myUser/.ssh/id_dsa.pub. The key fingerprint is:
7d:a9:f9:44:31:c3:d8:6c:d8:c1:d0:5f:39:f8:75:79 myUser@192.168.135.51

2. Copy your public key to the remote server

e.g.

>> scp .ssh/id_dsa.pub
myUser@192.168.135.99:.ssh/ Password: id_dsa.pub 100% 600 0.6KB/s
00:00

3. Login to the remove server and add your public key to the authorized keys.

e.g.

myUser@192.168.135.51:~> ssh -l myUser
192.168.135.99 Password: Last login: Tue Sep 29 17:02:47 2009 from
v-br.vpn.risaris >> cd .ssh/ >> cat id_dsa.pub >>
authorized_keys2

■ You should now be able to login to the remote server without a password.

In the case of problems, SSH informationwill appear in /var/log/messsages or /var/log/lastlog
■ Now that the server has been installed, you can query the server status from the Deployment
Wizard.

You can choose to view this status information in the DeploymentWizard, in a browser, or both.
■ Click the Display Server Status or the Display Status in Browser Window buttons to return
the status of the server.

■ You should now click Configure Driver(s) to create Portus drivers that are enabled in your li-
cense. If you choose to not add drivers now, they can also be created at a later stage, more in-
formation about defining drivers can be found in the Servers View section of this documentation.

The "DriverWizard" will present a list of licensed drivers, and come upwith all drivers selected
and ready to be defined. You may now just click the Configure button to define all of them, or
deselect those you do not need or want to set up at that stage.

Click "Configure".

In case the driver does not require any additional parameters to be set, it will be defined now,
otherwise the Driver Definition Dialog will ask for the additional parameter(s) to be set. e.g. for
an Adabas driver set the "ListMaxRecords" parameter. Click the Save button.

■ When Show (post-setup) Driver Information is selected, and information is available for the
driver(s) just installed, it will be displayed (cumulatively) after the driver(s) have been configured

■ ClickDone to close the Deployment Wizard
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■ Configure Portus using the Portus (Eclipse) Control Centre

Server Installation

This section outlines machine specific installation steps.

Host-type: Linux / *ix type

1. On the target machine, in the installation directory, execute the script ./installServer.sh.

Important: It is recommended that this script runs using the root user.

Important: If you wish to update an existing installation, run this script with the -update
option.

2. The script will check if the prerequisites are met.

3. Enter the full path of the Portus installation. Example: /usr/local/soaGateway

4. If required, specify the Software AG sagenv file that is to be used (an absolute path must be
used). Example: /opt/softwareag/sagenv.new

Note: If you do not have a sagenv file available, enter skip.

5. The next prompt asks what user Portus should be started as. If you included a valid SAGENV
file in the previous step, you should choose the user who runs Software AG products, normally
the "sag" user. Otherwise, if you started the script as root, lesser privileged user will be chosen,
normally wwwor nobody. If you did not start the script as root, the current user will be chosen.

6. The script now has all the information to commence the installation. Follow the on-screen in-
structions to start Apache.
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5 Installation verification
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Portus Server installation verification

To test if the Portus Server has come up correctly, you may issue, from a browser, the request

http://<server>:<port>/SoaGatewayStatus

Or, on Windows, you can select Start -> All Programs -> Portus v4.1.1 -> Portus Status

The Server should report its status. If it does not, see the Troubleshooting section.

After you have defined an accessible Resource, for example by pointing the installation supplied
"Employees" Resource to an actual Database id / File number of an Adabas "Employees" demo
file, issue the following request:

http://<server>:<port>/adabas_Employees?LIST&name=MEYER

which will, if set up correctly, display a list of employees with last name "MEYER" like this:

<?xml version="1.0" encoding="UTF-8"
standalone="no" ?> <adabasEmployees> <adabasEmployee>
<personnel_id>11600322</personnel_id>
<first_name>MARIANNE</first_name>
<middle_name>AGNES</middle_name> <name>MEYER</name>
<mar_stat>M</mar_stat>
<sex>F</sex><city>BREMEN</city>
<zip>2800</zip><country>D</country>
<area_code>0421</area_code> <phone>290755</phone>
<dept>SALE46</dept> <job_title>KASSIERERIN</job_title>
<leave_due>31</leave_due> <leave_taken>01</leave_taken>
</adabasEmployee> <adabasEmployee>
<personnel_id>20009200</personnel_id>
<first_name>LESLIE</first_name>
<middle_name>HENRY</middle_name> <name>MEYER</name>
<mar_stat>M</mar_stat> <sex>M</sex>
<city>SEATTLE</city> <zip>98105</zip>
<country>USA</country> <area_code>206</area_code>
<phone>147-4864</phone> <dept>MGMT30</dept>
<job_title>MANAGER</job_title>
<leave_due>12</leave_due> <leave_taken>08</leave_taken>
</adabasEmployee> <adabasEmployee>
<personnel_id>20023800</personnel_id>
<first_name>ARTHUR</first_name>
<middle_name>JOHN</middle_name> <name>MEYER</name>
<mar_stat>M</mar_stat> <sex>M</sex>
<city>STILLWATER</city> <zip>74074</zip>
<country>USA</country> <area_code>405</area_code>
<phone>724-8063</phone> <dept>MGMT30</dept>
<job_title>MANAGER</job_title>
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<leave_due>38</leave_due> <leave_taken>05</leave_taken>
</adabasEmployee> <adabasEmployee>
<personnel_id>20027900</personnel_id>
<first_name>DANIEL</first_name>
<middle_name></middle_name> <name>MEYER</name>
<mar_stat>D</mar_stat> <sex>M</sex>
<city>DENVER</city> <zip>80210</zip>
<country>USA</country> <area_code>303</area_code>
<phone>242-1213</phone> <dept>TECH05</dept>
<job_title>MANAGER</job_title>
<leave_due>19</leave_due> <leave_taken>06</leave_taken>
</adabasEmployee> </adabasEmployees>
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Introduction

This section outlines how to install the Portus Server on Windows

See here for installation troubleshooting hints.

Important: If the version you are installing is not Portus v2.4.2, then your installation may
display a different version number from the screenshots below. There is no functional in-
stallation difference between versions, so this can be safely ignored.

Installation using the Deployment Wizard

OnWindows, the Portus install is done via the Deployment Wizard. This is a wizard which runs
within Eclipse, and guides you through the steps required to install and configure your Portus
server.

■ Adialogwill be presented the first time the Portus Control Center is started after its installation.
Specify a project name and click Continue

■ To start the deployment wizard at any time, click the following button

The Deployment Wizard will appear
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■ Click "Browse" to select your license, choose your (Windows) installation kit from the list of
available and licensed kits.

Important: This license should reside on a local HDD (Hard Disk Drive), and not on a
network drive or SSD (Solid State Drive).

ClickNext
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■ The following screen allows you to either select an existing Portus server to deploy to, or to
define a new Portus server to the Control Center. This server definition will be used for server
administration later on.

For Windows, you should

1. Enter a 'friendly name'. This name will be used to refer to a Portus Server without needing
to enter the hostname (or IP) later on.

2. Enter the hostname or IP of the machine on which the Portus server will run. This host/IP
will be the machine you are currently working on. In many cases, entering localhostwill
suffice.

3. Enter the port which you would like Portus to listen for requests on. A new Apache web
server will be installed, you must ensure that the port choosen here is available for use and
not blocked by a firewall. The port entered here will utimately be the port that Portus uses
to service requests.

Important: Once you have filled in all of the above, click 'Add Server'
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The server will now be added to your Portus Control Center 'Servers View' for later use.

ClickNext
■ Now the Deployment Wizard must launch the Windows installer program.

Press the Launch Setup button
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■ The deployment wizard now starts an MSI installer to install the Portus Server component on
the system.

When the first page appears, clickNext
■ If you require Portus to be installed in a non-default directory, click Browse and select your
directory. Otherwise clickNext

■ Click Install to continue
■ Please wait while Portus is installed
■ When the installation is complete, click Finish
■ Return to the Deployment Wizard, the message log will indicate either success or failure of the
setup process.

ClickNext
■ The next screen is used to verify that your Portus is up and running, and then to configure it
based on your license.

1. Display Server Status: This displays this a short summary of the server status in the deploy-
ment wizard

2. Display Status in BrowserWindow:This displaysmore information about the servers status
in a browser.

3. Configure Driver(s): Allows you to automatically create drivers based on your license.
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■ You should now click Configure Driver(s) to create Portus drivers that are enabled in your li-
cense. If you choose to not add drivers now, they can also be created at a later stage, more in-
formation about defining drivers can be found in the Servers View section of this documentation.

The "DriverWizard" will present a list of licensed drivers, and come upwith all drivers selected
and ready to be defined. You may now just click the Configure button to define all of them, or
deselect those you do not need or want to set up at that stage.

Click "Configure".

In case the driver does not require any additional parameters to be set, it will be defined now,
otherwise the Driver Definition Dialog will ask for the additional parameter(s) to be set e.g. set
the "ListMaxRecords" parameter to a value of "0" (zero) for an Adabas Driver. Click the Save
button.

The Driver Wizard Dialog indicates the success of the operation
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■ When Show (post-setup) Driver Information is selected, and information is available for the
driver(s) just installed, it will be displayed (cumulatively) after the driver(s) have been configured

■ ClickDone to close the Deployment Wizard

Post installation steps

Now Portus is installed - what's next?

■ New to Eclipse ? Take an Eclipse getting started tour.
■ Configure Portus using the Portus Control Center
■ Proceed directly to define Web Services using Portus.

Server and Control Centre Installation34

Server and Control Center on Windows
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The following will guide you through the process of installing and starting the Portus server.

Using the Deployment Wizard to install on a z/OS host

Important: If the version you are installing is not Portus v2.4.2, then your installation may
display a different version number from the screenshots below. There is no functional in-
stallation difference between versions, so this can be safely ignored.

The next step then is to install and start the Portus server. To do this, you may have to deploy files
to a remote machine. For example, you want to run your Portus Control Centre on Windows, but
your Portus server on z/OS. You can use the deployment wizard to deploy the required files to
z/OS and start your server.

■ If this is the first time you've started the Control Centre, the Portus Perspective will be activated
automatically.

If, for some reason, the Portus Control Centre perspective has not started, clickWindow ->Open
Perspective -> Other and choose Portus Control Center (Admin) from the list. ClickOK

You will be asked to specify a project name or accept the default. Usually you will now simply
click the 'Continue' button, whichwill then start the 'DeploymentWizard' to guide you through
the process of defining your server within the Portus Control Center and transfer (FTP) the in-
stallation files to the Portus Server target machine.

■ If you, for whatever reason, opt to NOT run the Deployment Wizard at that time, you can start
the wizard anytime later on by clicking the Deployment action button in the title bar of the
'Portus' or 'Portus (legacy) Servers' view
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■ The Deployment Wizard will now start
■ Select your Portus license file.
■ From the list of licensed kits, select the z/OS kit.
■ ClickNext
■ The following screen allows you to either select an existing Portus server to deploy to, or to
define a new Portus server to the Control Centre. This server definition will be used for both
the deployment process as well for (remote) server administration later on.

■ To define a new server:

1. Enter a 'friendly name'. This name will be used to refer to a Portus Server without needing
to enter the hostname (or IP) later on.

2. Enter the hostname or IP of the machine on which the Portus server will run. This host/IP
will be used to send the install files ( via FTP ) andwill become the host/IP that you use when
issusing requests to Portus.

3. Enter the port which you would like Portus to listen for connections on.

A new Apache web server will be installed, you must ensure that the port choosen here is
available for use on the server machine.

The port entered here will utimately be the port that Portus uses to service requests.

4. Important: Once you have filled in all of the above, click 'Add Server'

5. The server will now be added to your Portus Control Centre 'Servers View' for later use.
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■ Alternatively, if an already defined server is to be used (i.e. installation files deployed to it),
check 'Deploy to existing Portus Server' and select a server from the list in the 'Existing Server
Information' section.

■ ClickNext
■ The next screen is used to deploy the installation files to the target machine, i.e. the machine is
where the Portus server will run.

■ The hostname / IP will have already been filled by what has been specified on the previous
page.

■ Enter the username which is used to login (via FTP) to the server machine (if required)
■ Enter the password (if required)
■ Enter a high-level qualifier to send the installation files to.

■ Important:
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■ Check the Create datasets box (in the target information group) if you want the wizard to
create the necessary datasets (recommended). Otherwise, these must be already allocated.
For more information, see here

■ Installation type. In most cases, this should be left asNormal . If the datasets that are being
sent are patch datasets, you should select Patch from the drop-down menu.

■ The Additional parameters group will allow you to enter the DSN(s) required for the operation
of the driver(s) to be installed. Parameters related to all licensed drivers are queried here, you
may omit those for all drivers you do not intend to use.

Note: Click the Help button(s) next to the DSN name input fields to view information
about each datasets purpose.

■ If your FTP server requires a port other than 21, you can specify that by selecting Specfic FTP
Port and entering the FTP port number.

■ If your FTP server requires passive mode transfers, you can enable this by selecting the Passive
Mode checkbox

■ Important: Click the Start FTP button to begin the FTP.

■ Once the FTP has completed, you need to logon to the target machine, and run the server-spe-
cific installation steps.
■ z/OS Installation Steps

■ Now that the server has been installed, you can query the server status from the deployment
wizard.

You can choose to view this status information in the DeploymentWizard, in a browser, or both.
■ Click the Display Server Status or the Display Status in Browser Window buttons to return
the status of the server.

■ You should now click Configure Driver(s) to create Portus drivers that are enabled in your li-
cense. If you choose to not add drivers now, they can also be created at a later stage, more in-
formation about defining drivers can be found in the Servers View section of this documentation.

The "DriverWizard" will present a list of licensed drivers, and come upwith all drivers selected
and ready to be defined. You may now just click the Configure button to define all of them, or
deselect those you do not need or want to set up at that stage.

Click "Configure".

In case the driver does not require any additional parameters to be set, it will be defined now,
otherwise the Driver Definition Dialog will ask for the additional parameter(s) to be set. e.g. we
set the "ListMaxRecords" parameter to a value of "0" (zero) for an Adabas driver. Click the Save
button.
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■ When Show (post-setup) Driver Information is selected, and information is available for the
driver(s) just installed, it will be displayed (cumulatively) after the driver(s) have been configured

■ ClickDone to close the Deployment Wizard

■ Configure Portus using the Portus (Eclipse) Control Centre

Server Installation

This section outlines machine specific installation steps.

Host-type: z/OS

Dataset Create

Important: This step can be ignored if you chose the Create Datasets in the Deployment
Wizard. If so, continue to here

The Portus Installation on z/OS uses 4 datasets, which must be created in advance. The datasets
can be any name you wish, so long as they each use the same high-level qualifier. This allows the
user to specify one dataset name prefix in the Java wizard, and the installation is based upon this
qualifier.

The 4 datasets to create are RECV, JCL, CONF, and ZIP.

For example, if the high-level qualifier is USER.INST001, then the followingwould be the datasets
that need to be created.

■ USER.INST001.RECV
■ USER.INST001.JCL
■ USER.INST001.CONF
■ USER.INST001.ZIP

The dataset attributes needed are as follows:

SIZEBLKSIZELRECLRECFMTypeName

see below312080FBSequentialRECV

312080FBPDSJCL

512508VBPDSCONF

see below1638416380VBSequentialZIP

These local files will be located in the directory where the wizard was started.
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XMIT File: AdabasSOAGateway/zOS/ASG.XMIT
ZIP File: AdabasSOAGateway/zOS/asg.zip

The size attribute for the RECV and ZIP datasets to be created on the zOS should be calculated as
follows:

RECV File: Divide the size of ASG.XMIT in bytes by 3120. Round the resultant size upwards to
the nearest integer to obtain the file size in blocks. We recommend a size of 9700 blocks.

ZIP File: Divide the size of asg.zip in bytes by 16380. Round the resultant size upwards to the
nearest integer to obtain the file size in blocks. We recommend a size of 700 blocks.

■ Enter the hostname or IP address of the z/OS system.
■ Select z/OS as the "Host type"
■ Enter the user ID
■ Enter the password
■ Enter the high-level qualifier used to create the datasets created earlier in the process.
■ If you wish to use a non-standard FTP port, click the "Specific FTP Port" checkbox and enter the
port to be used.

Sequential file containing the Portus load modules. This will be TSO RECEIVEd as
part of the installation process.

RECV

A job to perform a TSO receive.SOAGINS1JCL

A job which deletes, creates, initializes, and unzips the Portus file system into the file
system available to Apache in this environment. The DEL step of this job will finish

SOAGINS2

with CC=8 if the PFS dataset does not exist. Likewise, if the PFS dataset does exist, it
will be deleted by this job.

A job which copies a Apache's configuration file from a PDS member to the Portus
Environment.

SOAGINS3

A job which copies the license file the Portus Environment.SOAGINS4

A job which copies an Apache's SSLCONF configuration file from a PDS member to
the Portus Environment.

SOAGINS5

A jobwhich copies SSLCertificate and SSLKey files from the CONFPDS to the Portus
Environment.

SOAGINS6

A job which copies a file out of the Portus Environment to a dataset on zOS. Use only
at the request of Tech Support

SOAGCOPY

PROC to be used for running all other jobs.SOAGPROC

Job which starts the Portus Server.SOAGSTRT

PROC to be used for various utilities.PFSPROC

A job which copies Apache's error_log to an OUTPUT DDCARD if a failure occurs
during Portus initialization. Once the Portus server is initialized, this logwill bewritten
to the JES Spool.

CPLOGS
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A job which lists the contents of the Portus file system.PFSLS

A DB2 CLI Initialization File. If using DB2 Driver this will need to be modified to
reflect the Sub-System ID and location name. Your DBA can provide this information.

CLIINI

File used by Portus to declare environment variablesCONFIGCONF

A copy of the Portus's Apache configuration file. This can be edited and copied into
the Portus file system using SOAGINS3.

HTCONF

Run-time configuration fileGROUP

Run-time configuration fileHOSTS

Run-time configuration filePASSWD

Run-time parameters for debugging. Only to be used at the direction of supportDXRTRACE

Adabas Run parametersDDCARD

Run-time parameters.SYSPARM

License File.ASGLIC

A Sequential zip-file containing the Portus file system.ZIP

If you do not wish to install the Portus (Eclipse) Control Centre, proceed to z/OS Server Setup

You can either, logon to the z/OS host and setup the Portus Server, or install the client pieces now
(if selected) and run the server setup at a later time.

Submitting JCL and Starting Server

Review andmodify the following jobs prior to submitting them to reflect your installation standards
and the names of the datasets created during your installation.

1. Review and submit SOAGINS1 to TSO RECEIVE the Portus load library.

2. Review and submit SOAGINS2 to create, init, and populate the Portus file system.

3. Review and submit SOAGINS3 to copy theApache configuration file into the Portus filesystem.

4. Review and submit SOAGINS4 to copy the Portus license into the Portus filesystem.

5. If using the Adabas Driver review the DDCARDmember and specify the correct Adabas SVC
number. Under certain circumstances, the Adabas link routines may not pick up the SVC and
DBID values specified via DDCARD. In this case the SVC number and Database Id must be
zapped into ADALNKR, as described in the Adabas installation documentation, and the mod-
ified ADALNKRmade available in a STEPLIB library ahead of the one containing the original,
unzapped version.

6. If using the DB2/ODBC Driver review the CLIINI member and specify the correct MVSDE-
FAULTSSID and Location name.

Refer to you DBA for this information.

7. Submit SOAGSTRT to bring up the Portus (Apache) server. The server is ready to be usedwhen
you see the "XMiddLe ... is ready for requests" message in the XMIDCARD DD.
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Important: Restarting and stopping Portus: Due to the nature of the z/OS Apache config-
uration it is not possible to restart the server with a single command. The server must
be stopped with "/p jobName" and started by submitting SOAGSTRT again. In this
scenario, Apache may issue a warning about the httpd.pid being overwritten. This
warning can safely be ignored.

8. If the Portus Server is to be run as a started task (STC), copy SOAGSTRT to a procedure library.

Starting Server with HTTPS

To enable HTTPS connections, a sample SSL certificate and SSL sample key have been provided.
These are for development only, and should not be used in a production environment.

1. If you wish the server to listen on a non-default HTTPS port, review ...CONF(SSLCONF) and
change all instances of 443 to the port you wish to listen for HTTPS connections.

2. Edit the ...CONF(HTCONF) member and uncomment the Include conf/extra/httpd-ssl.conf
directive

3. Ensure the server has been stopped

4. Review and submit SOAGINS5 to copy SSLCONF into the Portus file system.

5. Review and submit SOAGINS3 to copy HTCONF into the Portus file system.

6. Edit SOAGPROC and change the server parameters to -X -DSSL

E.g. EXEC PGM=HTTPD,PARM='-X -DSSL',REGION=0M

7. Submit SOAGSTRT to bring up the Portus (Apache) server. The server is ready to be usedwhen
you see the "XMiddLe ... is ready for requests" message in the XMIDCARD DD.

HTTPS access can be tested by checking (change host and the HTTPS port to suit your system)

https://myServer:8443/SoaGatewayStatus

For more information on configuring Apache for HTTPS see here
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This section provides information about installing and running the Portus in the VSE operating
system environment. It covers the following topics:

Using the Deployment Wizard to install on a z/VSE host

The next step then is to install and start the Portus server. To do this, you may have to deploy files
to a remote machine. For example, you want to run your Portus Control Center on Windows, but
your Portus server on z/VSE. You can use the deployment wizard to deploy the required files to
z/VSE and start your server.

■ If this is the first time you've started the Control Centre, the Portus Perspective will be activated
automatically.

If, for some reason, the Portus Control Centre perspective has not started, clickWindow ->Open
Perspective -> Other and choose Portus Control Center (Admin) from the list. ClickOK

You will be asked to specify a project name or accept the default. Usually you will now simply
click the 'Continue' button, whichwill then start the 'DeploymentWizard' to guide you through
the process of defining your server within the Portus Control Center and transfer (FTP) the in-
stallation files to the Portus Server target machine.

■ If you, for whatever reason, opt to NOT run the Deployment Wizard at that time, you can start
the wizard anytime later on by clicking the Deployment action button in the title bar of the
'Portus Servers' view
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■ The Deployment Wizard will now start
■ Select your Portus license file.
■ From the list of licensed kits, choose the z/VSE kit.
■ ClickNext
■ The following screen allows you to either select an existing Portus server to deploy to, or to
define a new Portus server to the Control Center. This server definition will be used for both
the deployment process as well for (remote) server administration later on.

■ To define a new server:

1. Enter a 'friendly name'. This name will be used to refer to a Portus Server without needing
to enter the hostname (or IP) later on.

2. Enter the hostname or IP of the machine on which the Portus server will run. This host/IP
will be used to send the install files ( via FTP ) andwill become the host/IP that you use when
issusing requests to Portus.

3. Enter the port which you would like Portus to listen for connections on.

A new Apache web server will be installed, you must ensure that the port choosen here is
available for use on the server machine.

The port entered here will utimately be the port that Portus uses to service requests.

4. Important: Once you have filled in all of the above, click 'Add Server'

5. The server will now be added to your Portus Control Centre 'Servers View' for later use.
■ Alternatively, if an already defined server is to be used (i.e. installation files deployed to it),
check 'Deploy to existing Portus Server' and select a server from the list in the 'Existing Server
Information' section.

■ ClickNext
■ The next screen allows you to extract the z/VSE specific files to your local environment.
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■ Click the "Extract Files" button and extract the z/VSE files to your local system.
■ Using FTP, send your Portus license file into the SAGLIB.ASGvvv library. This file should be
named ASG41.LIC

Important: This file must be not be translated during the transfer, therefore ensure it is
transferred in binary.

Important: In case you did not restore the Portus sublibraries into a library named SAGLIB,
modify member CPLIC.P and update accordingly

Review SOAGINS3 and adjust the library/volume/extent settings. Submit this job to copy your
license file to the Portus filesystem.

■ If youwish to change the port that Portuswill listen on (default: 56000) transfer theHTTPD.CONF
file from z/VSE to your PC and edit it there. The directive to change is Listen.

Important: This file must be not be translated by the FTP, therefore ensure it is transferred
in binary.

Important: In case you did not restore the Portus sublibraries into a library named SAGLIB,
modify member CPHTTPD.P and update accordingly

Review SOAGINS4 and adjust the library/volume/extent settings. Submit this job to copy the
HTTPD.CONF file to the Portus filesystem.
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■ In case you did not restore the Portus sublibraries into a library named SAGLIB, modify member
CONFIG.P to point the SAG_RTS_ETC=FILE: setting from ///SAGLIB/ASG41114/to
///<yourlib>/ASG41114/

■ Review SOAGSTRT and adjust the library/volume/extent settings.

Ensure that an Adabas (or WAL (Adabas Limited)) v8 library is included in the LIBDEF, it is
essential for the operation of the Portus server that the level of Adabas is 8.1.3.02 or above .

If you plan to use the CICS Driver, ensure that Portus runs in OS390 emulation mode. Add the
"OS390" to the JCL, e.g.

// EXEC HTTPD,SIZE=AUTO,PARM='-DONE_PROCESS',OS390

Submit SOAGSTRT.JCL to start your Portus server.
■ In the Portus Server Deployment Wizard dialog click theDisplay Server Status or theDisplay
Status in Browser Window buttons to return the status of the server.

■ Click Finish to close the Deployment Wizard

■ Configure Portus using the Portus (Eclipse) Control Center

Operating the Portus server

■ Sizing the partition for the Portus server
■ Using a disk file for the ADARUN parameters

Sizing the partition for the Portus server

The Portus server, started with the parameters as delivered, will require a partition with ca. 500
KB 24-bit and 36 MB 31-bit storage, plus ca. 20 KB SVA-24 and 160 KB SVA-31 storage.

To find out how much free SVA space is available on the system issue the AR command GETVIS
SVA.

The output will look like this:

AR 0015 GETVIS USAGE SVA-24 SVA-ANY SVA-24 SVA-ANY
AR 0015 AREA SIZE: 1,872K 14,728K
AR 0015 USED AREA: 1,312K 6,788K MAX. EVER USED: 1,320K 6,800K
AR 0015 FREE AREA: 560K 7,940K LARGEST FREE: 560K 7,380K
AR 0015 1I40I READY

To get more information about SVA allocation and usage run the LIBR utility function LISTDIR
SDL.

The output will look like this:
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STATUS DISPLAY SDL AND SVA DATE: 2009-07-12
TIME: 22:25

--------------------------------------------------------------------
SDL TOTAL ENTRIES : 908 (100%)

USED ENTRIES : 514 ( 57%)
FREE ENTRIES : 394 ( 43%)

SVA(24) TOTAL SPACE : 2188K (100%)
USED SPACE : 1558K ( 71%)
- PFIXED AREA: 165K ( 8%) START AT: 002C7928
FREE SPACE : 630K ( 29%)

SVA(31) TOTAL SPACE : 7620K (100%)
USED SPACE : 6685K ( 88%)
- PFIXED AREA: 680K ( 9%) START AT: 051C6F00
FREE SPACE : 935K ( 12%)

--------------------------------------------------------------------
DIRECTORY DISPLAY SDL SORTED BY PHASE NAME DATE: 2009-07-12

TIME: 22:25
--------------------------------------------------------------------
M E M B E R ORIGIN SVA/MOVE LOADED PHASE ADDRESS ENTRY POINT

NAME TYPE SYSLIB MODE INTO SVA SIZE IN SVA IN SVA
--------------------------------------------------------------------
$$BACLOS PHASE YES MOVE 31 554 04BE6C48 04BE6C48
$$BATTNA PHASE YES MOVE 31 2216 04BE6E78 04BE6E78
$$BATTNK PHASE YES MOVE 31 1104 04BE7720 04BE7720
$$BATTNR PHASE YES MOVE 31 389 04BE7B70 04BE7B70
$$BCASI3 PHASE NO MOVE 31 838 04BEF880 04BEF880
$$BCLOSE PHASE YES MOVE 31 1192 04BE7CF8 04BE7CF8
$$BCLOS2 PHASE YES MOVE 31 624 04BE81A0 04BE81A0
$$BCLOS5 PHASE YES MOVE 31 1032 04BE8410 04BE8410
$$BCLRPS PHASE YES MOVE 31 712 04BE8818 04BE8818
$$BCVSAM PHASE YES MOVE 31 768 04BE8AE0 04BE8AE0
$$BCVS02 PHASE YES MOVE 31 326 04BE8DE0 04BE8DE0
$$BDYD$$ PHASE NO MOVE 31 104 04BEFBC8 04BEFBC8
...
...

Using a disk file for the ADARUN parameters

The Portus start job, SOAGSTRT.JCL, as distributed uses inline ADARUN parameters.

It may prove advantageous to put these parameters on a disk file instead, the following is sample
JCL to do this:
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* $$ JOB JNM=DITTOCS,CLASS=0,DISP=D
* $$ LST CLASS=A,DISP=D
// JOB DITTIOCS CARD TO SEQUENTIAL DISK FILE
// UPSI 1
// DLBL CARD,'SOAGATE.ADARUN.PARAMETERS',0,SD
// EXTENT SYS010,vvvvvv,1,0,ssss,1
// ASSGN SYS010,DISK,VOL=vvvvvv,SHR
// EXEC DITTO
$$DITTO CS FILEOUT=CARD,RECFMOUT=F,BLKSIZE=80
ADARUN PROGRAM=RENTUSER
ADARUN SVC=<your_ADABAS_SVC_number>
ADARUN DATABASE=<your_ADABAS_dbid>
/*
/&
* $$ EOJ

After having created the disk file replace the inline ADARUNparameters in SOAGSTRT.JCLwith
the appropriate sequence of DLBL CARD, EXTENT and ASSGN statements.
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Uninstall Portus Server - Linux, z/Linux, AIX and Solaris

1. Ensure the Portus server is not running.

Change to the <SERVER_install_dir>/apache2/bindirectory, replacing <SERVER_install_dir>with
the location where you installed the Portus server.

Run the command ./apachectl stop

2. The <SERVER_install_dir> can now be removed. Use the command rm -rf
<SERVER_install_dir>.

Important: Once you run this rm command, all files anddirectories in <SERVER_install_dir>
will be permanently deleted.

3. This completes the uninstall process.

Example:

# cd /usr/local/server/apache2/bin
# ./apachectl stop
# cd /usr/local
# rm -rf server
#

Uninstall Portus Server - Windows

1. Start the Windows Control Center by clicking Start -> Control Panel

2. Select theAdd or Remove Programs or Programs and Features (depending on your version of
Windows)

3. Select Portus 4.2.1 and click Change/Remove

4. Select Remove radio button and clickNext

5. ClickOK to uninstall Portus
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After having created a new environment, you may want or need to copy the existing service
definitions to your new server.

This is possible with either

■ Drag-and-Drop
■ The Copy Wizard

Note: When copying between Portus servers at the different software levels, the copy oper-
ation will compensate for differences in the structure of the server configration etc., should
this not be fully possible for some reason, error messages will indicate the reason(s).

The following scenarios are possible when copying configuration elements

No problems to be expectedCopy to a server at the same level

New features may have been introduced, default values may
be used for new elements.

Copy to a higher level server ("upgrade")

Loss of a certain amount of control information possible due
to elements not known by the down-level server

Copy to a lower level server ("downgrade")

Copy configuration with drag-and-drop

See here for more information on this feature.

Upgrading using the Copy Wizard

See here for more information on this feature.
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